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ABSTRACT 

CGT students of Purdue University, who seek employment upon graduation, are faced with the issue of not being 
familiar with all industry software packages. Students in CGT(Computer Graphics Technology) Animation are 
taught to use Autodesk Maya while students in CGC (Construction Graphic Communications) are primarily familiar 
with Autodesk 3D Studio Max. In both areas of concentration,  industry software packages tend to change and over-
lap, depending on the company. Students should be able to apply their learned software knowledge towards other 
applications in order to improve their employability. This paper seeks to offer a method of determining transfera-
bility of skill sets between Autodesk Maya and Autodesk 3D Studio Max. 

Introduction 
The areas of 3D animation and multimedia 

are becoming a major part of our society’s everyday 
culture, thus the demand for qualified and profes-
sional individuals in these areas is constantly grow-
ing. (Madhavan, Flexman, & Betker, 2008). 

With regard to these and other growing in-
dustries, the Department of Technical Graphics of 
Purdue University changed its name to the Depart-
ment of Computer Graphics Technology (CGT) and 
expanded its mission in 1997. Its new mission had 
developed to "prepare highly skilled, and sought af-
ter, graduates with the capacity to apply their prob-
lem solving skills across a growing and broad range 
of industries and businesses"(Department of 
Computer Graphics Technology, 2004). Presently, 
CGT graduates are employed in a wide variety of 
fields spanning over a diverse range of industries. 

 Despite the Department's expansion, an im-
portant matter which impacts these students still ex-
ists. CGT students at Purdue University, who seek 
employment upon graduation, are faced with the is-
sue of not being familiar with all industry software 
packages. When students graduate to pursue careers 
in industry, they are often required to use software 
packages that are not taught in their respective areas 
of interest. As such, CGT students should be able to 
apply and transfer their learned software knowledge 
towards other applications in order to improve their 
potential employment prospects. 

 This paper proposes a method for analyzing 
the transference of skill sets between 3D animation 
programs. A study utilizing both qualitative and 
quantitative data was conducted to assess the transfe-
rence of a certain skill set between the two most 

commonly used software packages in the Visual Ef-
fects (VFX), Computer Generated 
(CG), and Animation industries. According to nu-
merable sources including Kent Estep, Benoit Saint 
Moulin, and Derek Chimenti who have spent many 
years working in the animation and visual effects 
industry,  Autodesk 3D Studio Max and Autodesk 
Maya are the most commonly used software in these 
industries around the world(D.Chimenti, 2011) 
(Moulin. 2007). 

The methods that were used included gather-
ing variable data from pre-task and post-task surveys 
of both qualitative and quantitative measures and 
analyzing the results of an animation task. The expe-
rimental design and analysis of this method will be 
discussed later in the paper. 
 
Key Terms  
 To Transfer something, in the most literal 
sense, is to move something from one place, person, 
or thing to another. In terms of this paper, the transfer 
that was investigated is the transfer of a skill set, or 
according to Birkinshae, Bresman, Nobel, et. al, the 
learned power of doing something competently. In 
this way, "successful knowledge transfer…results in 
the received unit accumulating or assimilating new 
knowledge”(Birkinshae, Et al. 2010). 
  The skill set that was analyzed in this paper, 
is that of animation. To animate something, simply 
put, is to change an object's position over time. How-
ever in terms of the animation industry, to animate 
means "to make or design in such a way as to create 
the illusion of life-like movement" (Guidon. 2008). 
For the purposes of this paper, the type of animation 
that was  used is 3D animation. The concept of 3D, 



as it relates to this paper, corresponds to the dimen-
sionality of the software packages used. "These di-
mensions are defined by cardinal axes X,Y, and Z. 
These represent length (X), height (Y), and depth 
(Z)" (Guidon. 2008). 
 
Hypotheses 
  The hypothesis (H1) stated that there was a 
positive correlation between knowledge of Autodesk 
Maya and transference of the animation skill set to 
Autodesk 3D Studio Max and vice versa. 
 The experiment weighed this hypothesis 
against the null hypothesis (H0). The null hypothesis 
stated that there was no correlation between know-
ledge of Autodesk Maya and transference of the ani-
mation skill set to Autodesk 3D Studio Max and vice 
versa. 
 
Methodology 
 
Experimental Design 
 Two treatments were conducted on two sep-
arate days in order to test the transfer of the anima-
tion skill set from Autodesk Maya to Autodesk 3D 
Studio Max and, conversely, from Autodesk 3D Stu-
dio Max to Autodesk Maya. In the first treatment, 
participants were given a brief Maya Tutorial, while 
in the second treatment they were given a brief 3D 
Studio Max Tutorial.  
 The Maya tutorial explained the user inter-
face of the respective software packages as well as a 
guided breakdown of the first task in Autodesk Maya. 
The participants in this treatment were not given a 3D 
Studio Max Tutorial for the second task in Autodesk 
3D Studio Max. 
  Likewise, in the second treatment, partici-
pants were given a brief 3D Studio Max Tutorial, 
which explained the interface and provided a guided 
breakdown of the task in Autodesk 3D Studio Max. 
The participants in this treatment were not given a 
Maya Tutorial for the second task.  This design was 
utilized to help ensure that the knowledge gained was 
indeed being transferred and not created. The tuto-
rials used in the research can be found in the  corres-
ponding project folder on file in Knoy 329. 
 On the first testing day, participants were to 
complete the animation task in Autodesk Maya, fol-
lowed by the same animation task in Autodesk 3D 
Studio Max. Conversely, on the second testing day,  
participants were to complete the animation task in 

Autodesk 3D Studio Max, followed by the same ani-
mation task in Autodesk Maya. 
   The original design of the research experi-
ment called for using convenient sampling to separate 
participants into four testing groups: Maya Group, 
3D Studio Max Group, Control Group A, and Control 
Group B. The Maya Group and Control Group A 
would be tested on the first day. The 3D Studio Max 
Group and Control Group B would be tested on the 
second day. 
 The actual design of the research experi-
ment, however, only utilized two testing groups. The 
groups were instead separated into the two testing 
days: Group1 (Maya- Max) and Group2 (Max-
Maya).  This design was utilized due to the over-
whelming number of Maya knowledgeable students 
and the insufficient number of Max knowledgeable 
students. Furthermore, all of the participants who had 
no experience in either software package were only 
present on the Max-Maya testing day. 
 All testing groups received pre-task assess-
ments before the two animation tasks were given. 
The groups were then given post-task assessments 
following the two tasks. 
 The data was compiled into statistics and the 
results  will be discussed later in the paper. 
A visual breakdown of the proposed  research design 
is shown in figure 1. 
 
Participants 
 Participants in the Maya-Max Group had 
previous experience with Autodesk Maya, but  most 
had  little to no experience with Autodesk 3D Studio 
Max. However, participants in the Max to Maya 
Group had a wide variety of experience. Very few 
participants had 3ds Max experience, some 
participants had little to no experience in either soft-
ware, and  some participants had previous experience 
with Autodesk Maya as well. 
 There were 47 total participants who took 
part in the study. The study was composed of 37 male 
and 10 female students. The participants were all 
between the ages of 18 and 25 and 46 out of the 47 
participants were from the Department of Computer 
Graphics Technology, although they were solicited 
from multiple colleges and departments within Pur-
due University. 
 The total number of participants included in 
the study was 47. The study was composed of  37 
male students and 10 female students. The partici-
pants were all between the ages of 18 and 25  

 
 
 
 
 



 

 
 Fig1. (Proposed Methodology)
 
 
Tutorials 
 Both tutorials began with an explanation of 
their respective software's interface, basic camera 
manipulation, and key framing techniques as laid out 
by Marc Andre Guidon in Learning Autodesk Maya 
2008  (Guidon. 2008). These explanations also in-
cluded labeled screenshots of the software packages.  
Some of these screen shots are shown in figures 2 
and 3. 
 

 
Fig 2. (Autodesk Maya) 
 

 
Fig 3. (Autodesk 3ds Max) 
 

 
 The second portion of the tutorials outlined 
a guided breakdown of the first task, which the par-
ticipants would be asked to complete. Like the inter-
face portion, this was accompanied by screenshots of 
various components of the Maya or Max interfaces. 
To see all of the attached screenshots refer to the full 
tutorials in Appendix.  
 The last item given to participants described 
the second task which told the participants to create 
an identical animation to the one created in the first 
task using the unknown software. The only instruc-
tions given, other than the task specifications, were 
guided directions on how to save the finished file. 
This functioned as a means for the researchers to ana-
lyze each subject's product and was believed to have 
no impact on the task itself. 
 
Evaluation of Task 
The criteria was deemed an appropriate assessment of 
a  participant's animation  skill at the entry level by 
Professor Nicoletta Adamo-Villani. Professor Ada-
mo-Villani is an animation professor in the depart-
ment of  Computer Graphics at Purdue University 
(Adamo-Villani. 2011). 
 The criteria for evaluation of the two tasks 
included: 

1. The character's hand must wave twice 
2. The character must be framed in a right 

perspective view 
3. The character must look at the camera 
4. The animation must be 2 seconds long 

  



 One point was awarded for each successful-
ly completed criterion.  Zero points were given for 
each unsuccessfully completed or incomplete criteria.  
 
Surveys 
  Many studies have concluded that using pre 
and post task surveys is a better method for analyzing 
a participant's ability in a given task as opposed to a 
time-based variable for assessment (Yuan, Chang. 
2008). 
  Studies have shown that time is not an ade-
quate measure in terms of successful task perfor-
mance. (Machin, Fogarty. 2003). In addition, using a 
time-based variable for assessment was believed to 
be unfair to those who had little to no experience in 
either software package. Experienced users may have 
chosen not to read the tutorial material provided, and 
thus have a faster performance time. Therefore, the 
research study has followed the pre-task and post-
task assessment method. 
 The pre-task and post-task assessments were 
measured through the employment of a revised Scale, 
which acts as both a qualitative and quantitative 
measure to assess participants' feelings on a particular 
subject.  The revised Likert scale that was used for 
the study featured a 4-point scale instead of the tradi-
tional 5-point  scale which features a neutral mid-
point. The remaining 4 points featured correspond to 
a traditional Likert scale: Strongly Disagree(1), Dis-
agree(2), Agree(3), Strongly Agree(4). 
 Numerous studies have demonstrated trends  
that by eliminating the middle point of a traditional 
Likert Scale, one can reduce "social desirability bi-
as." This bias is described as the innate desire to not 
stand out by offering opinion. (Garland. 1991), 
(Friedman. 1981), and (Cox. 1980). Therefore, the 
surveys implemented in the research study eliminated 
the middle point in order to reduce this bias. 
 A 4-point revised Likert scale was used as 
opposed to a 6-point scale due to the fact that, ac-
cording to Steven Morgan Balog in the Purdue Statis-
tics Department,  "a six point scale would be more 
complicated in terms of statistics. It is far more 
common in statistical regressions of this sort to fea-
ture data from a four point scale" (Balog. 2011). 
 In terms of their functions, the pre-task as-
sessment was used as a means of gathering demo-
graphic data from the participants as well as deter-
mining their experience levels using the two software 
packages. The post-task assessment was used as a 
means to gauge participants' responses to the task as 
well as to appraise their own perceptions of the soft-
ware transferability. The surveys used in the research 
study can be found in Appendix. 
 
 

Results 
 
Variables 
 After each task was evaluated as described 
above, the evaluation data, along with the data col-
lected from the pre-task and post-task assessments, 
were recorded and analyzed. The variables included 
in the regression model were: 

1. InitialMaya 
2. InitialMax 
3. TechnicalSkill 
4. ResponseMaya 
5. ResponseMax 
6. MayaSkill 
7. MaxSkill 
8. PerceivedSuccess 
9. PerceivedHinder 

 
 The variables IntialMaya [1], InitialMax [2], 
and TechnicalSkill [3] were retrieved from the pre-
task survey questions #5, # 7, and #8 respectively. 
The variables ResponseMaya [4], ResponseMax [5], 
PerceivedSuccess [8], and PerceivedHinder [9] were 
retrieved from the post-task survey questions #2, #4, 
#5, and #6, respectively. Finally, the variables 
MayaSkill [6] and MaxSkill [7] were retrieved from 
the task evaluations. These specific variables were 
included under the recommendation of Steven Mor-
gan Balog (Balog.2011). 
 
Process 
 After inputting the data for both testing 
groups, two linear regression models were calculated. 
The dependent variable for the two testing groups 
differed. In Group1 (Maya-Max). the dependent vari-
able, MaxSkill [7] was analyzed using InitialMaya 
[1], InitialMax [2], ResponseMaya [4], ResponseMax 
[5], TechnicalSkill [3], and PercievedSuccess [8] as 
independent variables. However, in Group2 (Max-
Maya), MayaSkill [6] was analyzed as the dependent 
variable InitialMaya [1], InitialMax [2], Response-
Maya [4], ResponseMax [5], TechnicalSkill [3], and 
PercievedSuccess [8] as independent variables. In 
both testing groups, the variable PercievedHinder [9] 
was not found to be a significant contributing varia-
ble to the linear regression model and was thus re-
moved from the model. 
 
Data 
 The data from both testing Groups were 
interpreted to ANOVA tables and Model Summary 
tables. From these, the data were transformed into 
graphical representations such as histograms, normal 
regression plots, and Box Plots. 
 
 



Group1 
 The ANOVA table for Group1 (figure 4) 
has demonstrated a high significance level of .01. 
According to this data, there is only a 10%  possibili-
ty that this result could have happened by chance. In 
other words, the test seems to indicate that there is a 
strong statistical significance to this data. 
 

 
Fig.4 (ANOVA Table) 
 
 Although there appeared to be a strong sta-
tistical significance to this data, the Model Summary 
table (figure 5)  has depicted an R2 value of .539. In 
this test, the R2 value denotes the explained variance 
of the model. In other words, the variables used in the 
model explained only about 54% of the data. Upon 
consulting Steven Balog, the data was confirmed to 
be sound. According to Balog, " in linear regressions 
of experiments of this kind, it is not uncommon to 
have this type of R2 value. The data is still 
sound"(Balog. 2011). 

 
Fig. 5 (Model Summary Table) 
 
 The histogram of the information (figure 6) 
has demonstrated that the data roughly followed the 
normal probability distribution. This indicated that a 
regression model was adequate for the data, as the 
error terms were roughly normal.  

 
Fig 6. (Maya-Max Histogram) 
 
 Similarly, the information seemed to indi-
cate that the data roughly followed a normal regres-
sion plot (figure 7). A regression plot is a graphical 
method for comparing two probability distribu-
tions by plotting their quantiles against each other. 
This information seemed to demonstrate that the sta-
tistical assumptions made about the data were sup-
ported.  

 
Fig.7 (Normal Regression Maya-Max) 
 
 The Box Plot of the variables used revealed 
an interesting observation (figure 8). Box Plots dis-
play differences between populations without making 
any assumptions of the underlying statistical distribu-
tion. The spacing between the different parts of the 
box help indicate the degree of dispersion and 
skew of the data, as well as identify outliers. The 
information demonstrated that the variables used in 
the regression model appeared to be significant in 



determining the end result. 

 
Fig 8. (Box Plot Maya-Max) 
 
 An interesting observation was made 
through a comparative analysis (figure 9) between a 
participant's MaxSkill [7] and PerceivedSuccess [8]. 
The PerceivedSuccess [8] variable was the degree of 
which the participant believed that their skills in the 
known program helped them to be successful in the 
other.  
 The data appeared to express that there is a 
strong positive correlation to the participants' Max 
skill and the degree of which their skills in the known 
program helped them to be successful in the other.  
 

 
 Fig 9. (Max Skill Transition Success) 
 
 Another interesting observation was made 
through a comparative analysis (figure 10) between a 
participant's MaxSkill [7] and InitialMaya [1]. The 
InitialMaya [1] variable was the degree of expertise 
which the participant believed he or she possessed at 
the beginning of the experiment.  
 The data appeared to express that there was 
a strong positive correlation to the participants' 
MaxSkill and the degree of expertise which the par-
ticipant believed  he or she possessed at the begin-
ning of the experiment. This data seemed to suggest 
that there was a positive correlation between know-

ledge of Autodesk Maya and transference of the ani-
mation skill set to Autodesk 3D Studio Max.  
 

 
Fig.10( Skill-Score Day1) 
 
Group2 
 The ANOVA table for Group2 (figure 11)  
has also demonstrated a very high significance level 
of .001. According to this data, there is only a 1% 
possibility that the result could have happened by 
chance. In other words, the test seemed to indicate 
that there was a very strong statistical significance to 
this data. 

 
Fig. 11 (ANOVA Table Max-Maya) 
 
   An interesting observation was seen in the 
Model Summary table for Group2 (figure 12). This 
Model Summary table depicted a  much higher R2 
value of .805. Therefore, the variables used in the 
model explained about 81% of the data.  

 
Fig. 12 (Model Summary Table Max-Maya) 
 
 The histogram of the information on Group2 
(figure 13) demonstrated that the data roughly fol-
lowed the normal probability distribution. This ap-
peared to indicate that a regression model was ade-



quate for the data, as the error terms were roughly 
normal.  

 
Fig 13. (Max-Maya Histogram) 
 
 Again, the information demonstrated that the 
data roughly followed the normal regression plot 
(figure 14). The data for this normal regression indi-
cated a stronger correlation than the data for Group1. 
This information appeared to demonstrate that the 
statistical assumptions made about the data were 
sound. 

 
Fig.14 (Normal Regression Max-Maya) 
 
  The information from Group2's Box Plot 
(figure 15) appears to demonstrate that the variables 
used in the regression model are not as significant in 
determining the end result. Upon consulting Steven 
Balog, however the data was still confirmed to be 
sound. According to Balog, "the variables are still 
important to the data by acting as stabilizers for the 
model" (Balog. 2011).  

 
Fig 15.( Box Plot Max-Maya) 
 
  Corresponding to the comparative analysis 
chart of Group1 (figure 9), another interesting obser-
vation was made through a comparative analysis  of 
Group2's data(figure 16).The analysis was conducted 
between a participant's MayaSkill [6] and Perceived-
Success [8].  Again, the PerceivedSuccess [8] varia-
ble was the degree  of which the participant believed 
that their skills in the known program helped them to 
be successful in the other.  
 The data appeared to express that there was 
a positive correlation to the participants' Maya skill 
and the degree of which their skills in the 3D Studio 
Max helped them to be successful in Maya.

 
 Fig 16. (Maya Skill Transition Success) 
 
 Another interesting observation correlating 
to the comparative analysis of Group1's data (figure 
10) was conducted on the data from Group2 (figure 
17). The analysis was conducted between a partici-
pant's MayaSkill [6] and InitialMax [2]. The Initial-
Max [2] variable was the degree  of  expertise which 
the participant believed  he or she possessed at the 
beginning of the experiment.  
 The data did not appear to express that there 
was a strong positive correlation to the participants' 
MaxSkill [7] and the degree of expertise which the 
participant believed  he or she possessed at the be-
ginning of the experiment. This data seemed to sup-
port the null hypothesis that there is no correlation 



between knowledge of Autodesk Max 3D Studio Max 
and the transference of the animation skill set to Au-
todesk Maya.  
 

 
Fig.17(Skill-Score Day2) 
 
Discussion 
 
Issues and Complications  
 The trends that were indicated through the 
data and graphical representations were believed to 
be influenced by a few key confounding variables. 
 The primary confounding variable appeared 
to be that there was not significant variation in the 
groups. As previously stated, the number of students 
that were knowledgeable in Maya was overwhelm-
ing. 30 out of the total 47 had experience in Maya, 
while only a meager 5 had prior experience in 3D 
Studio Max, 2 of which also had experience in Auto-
desk Maya. 
 In addition, the majority of participants who 
had little to no experience in either software were 
only present on the Max-Maya day of testing. Fur-
thermore, some participants who had previous expe-
rience in Maya were present on the Max-Maya test-
ing day,  despite the listed  participant requirements 
of the experiment. 
 
Recommendations for Further Research 
 It is believed that this type of research merits 
further study. Should an experiment similar to this 
study be conducted,  the researchers of this experi-
ment would like to offer a few additional recommen-
dations to consider before proceeding: 

1. Future researchers should acquire a larger 
number of participants from multiple de-
partments. A larger number of participants 

from varying backgrounds may improve the 
significance of the data. 

2. Future researchers should invoke a prelimi-
nary screening of the participants to ensure 
that they fall into the correct testing catego-
ries. 

3. Further research including an additional test-
ing group containing individuals who pos-
sess knowledge of both software packages 
may prove beneficial. 

4. Further research detailing the transferability 
of additional skill sets other than the anima-
tion skill set may prove beneficial. 

5. This type of study may be used as a frame-
work for determining skill transferability be-
tween other types of software programs. 

 
Conclusions 
  In conclusion, the data  supported the hypo-
thesis (H1) that suggested that that there was a posi-
tive correlation between knowledge of Autodesk 
Maya and the transference of  the animation skill set 
to Autodesk 3D Studio Max.   
 However, the data did not entirely reject the 
null hypothesis (H0). The data suggested that there is 
no correlation between knowledge of Autodesk 3D 
Studio Max and the transference of the animation 
skill set to Autodesk Maya 
 CGT students at Purdue University, who 
seek employment upon graduation, are and always 
will be faced with the issue of not being familiar with 
all industry software packages. However, this study 
appeared to indicate that CGT students may not have 
to be familiar with all proprietary software packages 
in order to work successfully in industry. CGT stu-
dents should be able to apply their learned software 
knowledge towards other industry  applications. The 
data appears to support the fact that CGT students at 
Purdue University indeed are acquiring "the capacity 
to apply their problem solving skills across a growing 
and broad range of industries and businesses." 
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Appendix 
 This section contains all materials used in conjunctions with this study. 
____________________________________________________________________________________________ 

Maya Tutorial 
Interface 

 
1. The Grid: This is the working plane. The grid uses XYZ coordinate system which is indicated by the axis 

located on the bottom left of the window. Y correlates to the up/down. X correlates to the left/right. Z cor-
relates to the front/back. 

2. The View Cube: Clicking the sides on the view cube will allow you to switch the view from the current 
Perspective view to the Front, Right, or Top View. After clicking a view, the arrows will allow you to ro-
tate the cube to see different angles. To return to the original Perspective view, click the Home Icon located 
next to the View Cube. 

3. The Move Tool: This tool allows you to translate or move an object along the XYZ axis. 
4. The Rotate Tool: This tool allows you to rotate or pivot an object at any angle. 
5. The Scale Tool: This tool allows you to enlarge or shrink an object to any size. 
6. Single Perspective Window: this button returns you to the single Perspective window. 
7. Four View Layout:  this button allows you to see the Front, Side, Top, and Perspective views simultaneous-

ly. To look at a single window, left click the window and hit the Spacebar. To return to the Four View 
Layout, click the button again or hit the Spacebar. 

8. Time Line: This bar shows the frames of the animation and the keys. Default time line setting is 24 frames, 
ie. 1 second of animation. 
 
Moving Around In Maya 
 
1. Dolly In/ Dolly Out: To dolly, or move in or out, hold Alt+ Right mouse button. 
2. Panning: To pan, or move the camera up, down, left, right; hold Alt+ Middle mouse button. 



3. Rotating:  To rotate or piviot the camera, hold Alt+ Left mouse button. 
Setting Keys and Animating 

 
1. On the starting frame, high-

light the attributes[translate, 
rotate, scale] you want to 
animate in the Channel Box 
located on the upper right.  
Hold the right mouse button 
and drag down to Key Se-
lected. 

2.  On the ending frame,  high-
light the attributes[translate, 
rotate, scale] you want to 
animate in the Channel Box.  
Hold the right mouse button 
and drag down to Key Se-
lected. 

3. Play back the animation using 
the Playback button located in 
the bottom right corner of the 
screen. 

4. When the animation is done, 
Right Click on the Timeline 
and go down to Playblast and 
click the box next to it.  

5. In the Playblast Options di-
alogue box, you can change 
the settings of the playlbast. 
Make sure the save to file 
checkbox is checked. After 
you name your file, Click the 
Playblast button and you will 
be able to see it played in y
Media Player. 

our 

 

 
 
 

 
 

 



TASK 1 
You will create a simple animation using Autodesk Maya. You will need to make the Character wave his hand twice 
in 2 seconds. Remember, there are 24 frames per second. You must also frame the character in a perspective view 
with the character looking at the camera. When the task is done, save a Playblast file to the folder named T1. Save 
the file as (your subject #)_T1.avi.  When you have finished the task, please notify one of the Media4orce members 
and they will give you the second part of the task. 
Breakdown 
Step 1: Getting Started 
 -File> Open Scene > Desktop>  T1.mb. 
 -In the boxes below the timeline on the lower right. (where it says 24 and 24) change these values to 48. 
Step 2: Making Waves: 
 -Rotate the  arm and hand as shown in the image  below: 

 
 - Key the Rotate X  attribute to approximately -60 in the channel box on frame 1. 
 -Go to frame 9 and change the Rotate X attribute to approximately -100. 
 -Go to frame 18 and change the Rotate X attribute to approximately -30 
 -Go to frame 27 and change the Rotate X attribute to approximately -100. 
 -Go to frame 36 and change the Rotate X attribute to approximately -30 
 -Go to frame 48 and change the Rotate X attribute to approximately -60. 
 
Step 3: I'm Ready for my Close-up, Mr. Director. 
 -Rotate, pan, and dolly the camera so that you are looking at the character like in the image above. 



Step 4:  Look at the Birdie 
 -Turn the character's  head so that you  he is looking at the camera. (Change the Rotate Y Attribute. 
Step 5: Play it again, Sam. 
 -Click the playback button to see your animation. When you are satisfied, click it again to pause it. 
Step 6:  Let's Make a Movie 
 -Right click the Timeline and scroll down to Playblast and click the option box. 
 -  Click Browse and save a Playblast file to the folder named T1. Save the file as (your subject #)_T1.avi.   
 

END OF TASK 1 
notify a Media4orce Representative to begin Task #2 

____________________________________________________________ 
TASK 2 

You will create a simple animation using Autodesk 3D Studio Max. You will perform the same task you just ac-
complished, but there will be no tutorial. You will need to make the Character wave his hand twice in 2 seconds. 
Remember, there are 24 frames per second. You must also frame the character in a perspective view with the cha-
racter looking at the camera. When the task is done, save a Playblast file to the folder named T2. Save the file as 
(your subject #)_T2.avi.  When you have finished the task, please notify one of the Media4orce members and they 
will give you the post-assessment survey. 
_____________________________________________________________________________________________ 

Max Tutorial 
Interface 

 
9. The Grid: This is the working plane. The grid uses XYZ coordinate system which is indicated by the axis 

located on the bottom left of the window. Z correlates to the up/down. X correlates to the left/right. Y cor-
relates to the front/back. 



10. The View Cube: A single left-click on the sides on the view cube will allow you to switch the view from 
the current Perspective view to the Front, Right, or Top View. Left-clicking and holding, on the View Cube 
will allow you to rotate the cube to see different angles. Left-clicking and dragging on the circular compass 
below the View Cube will allow you to rotate around the center of the grid. To return to the original Pers-
pective view, click the Home Icon to the top left of the View Cube (or press z). 

11. The Move Tool: This tool allows you to translate or move an object along the XYZ axis. 
12. The Rotate Tool: This tool allows you to rotate or pivot an object at any angle. 
13. The Scale Tool: This tool allows you to enlarge or shrink an object to any size. 
14. Time Line: This bar shows the frames of the animation and the keys. Default time line setting is 100 

frames.  
15. Transform Attributes: The transform attributes allow you to type in specified angles, distances, or sizes for 

each of the three axes for rotation, translation, and scaling respectively. 
16. The Time Slider: This allows you to select a particular frame for keying purposes. Simply drag the blue box 

to change the Frame number.  
 
Moving Around In Max 
 
4. Dolly In/ Dolly Out: To dolly, or move in or out, Alt + scrolling the mouse wheel.  
5. Panning: To pan, or move the camera up, down, left, right; middle mouse click and drag. 
6. Rotating:  To rotate or pivot the camera, hold Alt+ middle mouse button. 
Setting Keys and Animating 

 
6. With the desired frame chosen 

with the Time Slider, select 
the proper tool [translate, ro-
tate, scale] and manipulator. 
Then type in a specific num-
ber in the Transform 
Attributes of either X, Y, or Z. 

7.  Hit the Set Key button at the 
bottom of the screen till you 
see a red border on screen, 
double check the Time Slider 
is where you want it, and hit 
the key-shaped button. 

8. Move the Time Slider to the 
next desired key, and with the 
Set Key button still activated 
again hit the key-shaped but-
ton.  

9. Play back the animation using 
the Play Animation button lo-
cated in the bottom right cor-
ner of the screen. 

10. When the animation is done, 
go to Tools > Grab Viewport 
> Create Animated Sequence 
File  to Create a .avi preview 
of your animation.  

11. In the Make Preview dialogue 
box, you can change the set-
tings of the Animated Se-
quence File. Make sure the 

 
 
 

 
 



FPS is set to 24, and then 
click on Microsoft Video 
1/Choose Codec. Here make 
sure it is set to Microsoft Vid-
eo 1, Compression Quality 
100, and Capture Every 1 
Frame. For help retrieving 
your .avi file see the Task de-
scription below. 
 

 

 
 

TASK 
You will create a simple animation using Autodesk 3D Studio Max. You will need to make the Character wave his 
hand twice times in 2 seconds. Remember, there are 24 frames per second. You must also frame the character in a 
perspective view with the character looking at the camera. When the task is done, save a Preview file to the folder 
named T2. Save the file as (your subject #)_T2.avi.  When you have finished the task, please notify one of the Me-
dia4orce members and they will give you the second part of the task. 
Breakdown 
Step 1: Getting Started 
 -File> Open Scene > Desktop> T2.max. 
 -Left of the eight buttons in the bottom right of the screen is a Calendar/Clock symbol. Click it. In the di-
alogue that pops up under Animation change End Time from 100 to 48. 
Step 2: Making Waves: 
 -Rotate the arm and hand as shown in the image below: 



*Note: only manipulate the circular manipulator objects, NOT the geometry of the character itself*  

 
 -With the rotation tool selected, click the gray manipulator around the shoulder joint and key the X attribute 
in the Transform Attributes to -82.823 (make sure the Slider is on frame 0). 
 *Reminder: to set a key, click the Set Key Button. Ensure the Time Slider is in the proper position. 
Then, with the desired manipulator selected hit the key shaped button.* 
 - With the Time Slider still on frame 0, select the elbow manipulator (gray circle) and key the X attribute to 
approximately -170. 
 -Go to frame 9 and change the X attribute to approximately -130. 
 -Go to frame 18 and change the X attribute to approximately -110. 
 -Go to frame 27 and change the X attribute to approximately -140. 
 -Go to frame 36 and change the X attribute to approximately -110 
 -Go to frame 48 and change the X attribute to approximately -170. 
Step 3: I'm Ready for my Close-up, Mr. Director. 
 -Rotate, pan, and dolly the camera so that you are looking at the character like in the image above. 
Step 4:  Look at the Birdie 
 -Turn the character’s head so that he is looking at the camera. (Change the Rotate Z Attribute. 
Step 5: Play it again, Sam. 
 -Click the Play Animation button to see your animation. When you are satisfied, click it again to pause it. 
Step 6:  Let's Make a Movie 
 - Go to Tools> Grab Viewport> Create Animated Sequence File 
 -In the Make Preview dialogue, change Playback FPS to 24. 
 -Under Output click Microsoft Video 1 and set “Key Frame Every” to 1 Frame. 
 -Click Ok. Then click Create. 
 - To retrieve your .avi file, go to System(C:) > Users > Your Username >My Documents > 
3dsMaxDesign>Previews 
 -  Rename the file as (your subject #)_T2.avi  and drop it in the folder named T2 

END OF TASK  
Notify a Media4orce Representative to begin Task #2 

 
TASK 2 

You will create a simple animation using Autodesk Maya. You will perform the same task you just accomplished, 
but there will be no tutorial. You will need to make the Character wave his hand twice in 2 seconds. Remember, 
there are 24 frames per second. You must also frame the character in a perspective view with the character looking 
at the camera. When the task is done, save a Playblast file to the folder named T1. Save the file as (your subject 
#)_T1.avi.  When you have finished the task, please notify one of the Media4orce members and they will give you 
the post-assessment survey. 



___________________________________________________________________________ 

 

 

Pre-Test Survey 

Subject #_________ 

1. Are you: 
a. Male 
b. Female 
c. Choose not to answer 

2. do you have any impairments that may hinder your ability to perform a computer-based task. 
a. Yes 
b. No 

_____________________________________________ 

*If you answered Yes to question #4, please inform a Media4orce representative. At this stage, we 
ask that you turn in your pretest. You will still receive compensation for your time, however we 

cannot use your data for this research task. 

3. Are you a Computer Graphics Technology major? 
a. Yes 
b. No 

Evaluate the following based on 

1= Strongly Disagree 

2= Disagree 

3= Agree 

4= Strongly Agree 

*[Put a check mark on top of the number] 

4. I would consider myself knowledgeable in Autodesk Maya. 
___ ___ ___ ___   

  1   2   3   4    

5. I have acquired the skills necessary for basic animation in Autodesk Maya. 
___ ___ ___ ___   

  1   2   3   4  

6. I would consider myself knowledgeable in Autodesk 3D Studio Max. 
___ ___ ___ ___   

  1   2   3   4  

 



7. I have acquired the skills necessary for basic animation in Autodesk 3D Studio Max. 
___ ___ ___ ___   

  1   2   3   4  

8. I typically have no trouble acquiring new technical skills. 
___ ___ ___ ___  

  1   2   3   4    

9.  I consider myself proficient in computer literacy. 
___ ___ ___ ___  

  1   2   3   4 

_____________________________________________________________________________________________ 

Post-test Survey 

Evaluate the following based on 

1= Strongly Disagree 

2= Disagree 

3= Agree 

4= Strongly Agree 

1. I would consider myself knowledgeable in Autodesk Maya. 
___ ___ ___ ___   

  1   2   3   4    

2. I have acquired the skills necessary for basic animation in Autodesk Maya 
___ ___ ___ ___   

  1   2   3   4    

 

3. I would consider myself knowledgeable in Autodesk 3D Studio Max. 
___ ___ ___ ___   

  1   2   3   4    

4. I have acquired the skills necessary for basic animation in Autodesk 3D Studio Max. 
___ ___ ___ ___   

  1   2   3   4  

5. I found the Maya task easy to accomplish 
___ ___ ___ ___   

  1   2   3   4    



 

6. I found the Max task easy to accomplish 
___ ___ ___ ___   

  1   2   3   4  

7. Based on the test I just completed. I would likely pursue a career which required the use of a competi-
tive/similar software to that which I am familiar with. 

___ ___ ___ ___   

  1   2   3   4  

8. My knowledge in one software package helped me to be more successful in the other. 
___ ___ ___ ___   

  1   2   3   4   

_____________________________________________________________________________________ 

 

CHECKLIST EVALUATION FOR TASK 

Subject #______________ 

1. Is the camera framed in a right perspective view? 
 
Satisfactory    Not Satisfactory 

2. Is the character looking at the camera? 
 
Satisfactory    Not Satisfactory 

3. Is the animation 2 seconds long? 
 
Satisfactory    Not Satisfactory 

4. Does the character wave twice? 
 
Satisfactory    Not Satisfactory 
 
______________________________________________________________________________________ 

end of Appendix 

 

 

 

 

 

 



 

 

 

  

 

  

 
 
 
 
 
 

 
 


